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Demonstration Notes for Molecular Analyst 2-D PAGE
The following notes are designed to offer sufficient advice on how to perform a fairly full,
informative and convincing demonstration of the software. However, as any good
salesperson knows, attention should be paid to the customers needs and desires and the
demonstration should be tailored accordingly. Unlike the 1D work, which can be used by a
wide variety of scientists doing very different types of experimental work, people carrying
out 2D work are usually looking to obtain the same type of data. They obviously are all
working with protein mixtures which have been separated in the standard procedure i.e.
isoelectric focusing in the first dimension followed by electrophoresis for separation by size
in the second dimension.
How to avoid a bad demonstration:
1. Know your customer’s needs and wants. It is important to know what will excite
your customers and what will not interest them. Find out the customers needs and wants,
and their level of computer knowledge. You may then make a demonstration according to
your customers specific needs.
2. Always keep control. Do not let customers force you to show features when it is not
appropriate at the stage of the demonstration. A two or three stage demonstration is often
a good idea:• First perform a general demonstration that shows the quality of the product and
provides an overview of the features.
• The second part of the demonstration then involves an in depth discussion and
demonstration of certain features that are pertinent to the customers
requirements.
3. Do not sell for the competition! Only mention the competition if you are sure the
customer is very familiar with that competitor. If you do mention the competition, always
start by praising some minor feature before pointing out the reasons why the Molecular
Analyst software is so much better.
4. Know what to do next and when. A sales professional will always know what steps
are required and when they should be performed before the sales can be
closed. (e.g. quotations, follow up calls, additional information and possible second
demonstrations.)

THE MOST IMPORTANT PIECE OF ADVICE WE CAN OFFER IS:

PREPARE YOURSELF
Molecular Analyst 2-D PAGE is very easy to use, is flexible in its operation, and very
powerful in its analysis capabilities. It represents a significant advance in the analysis of 2D
gels.
We CANNOT emphasise strongly enough that it is essential for anyone who is to
demonstrate the 2D software MUST be fully prepared for the task.
2D Electrophoresis is a complex procedure and the analysis of series of 2D gels is also a
complex procedure. There are often lots of spots of varying sizes and intensities scattered
over an often fairly large area. This implies that the software required to carry out this task
is, by necessity, complex and therefore has to be fully understood and familiar before
demonstrating to a prospective customer.
The best preparation that you can do is practice using the software on a regular basis and
become familiar with analysing a wide range of different types of 2D gels BEFORE trying to
analyse a new sample from a prospective customer.
When demonstrating the software, be fully aware also of the performance issues at hand.
You are selling high quality image capture equipment which is able to produce large image
files, maybe as big as 20Mbytes. Do not attempt to analyse this size of image in front of the
customer as processing times can seem very long. When Pharmacia and other competitors
demonstrate their products, they use small images files (around 2Mbytes each) and
therefore promote their product in the best possible light. The software is supplied with
sample images of around 1.5Mbytes each, and we suggest that that these are employed
during the initial part of the demonstration at least. Sell the product by making sure we are
showing it in comparable circumstances.

Stage 1

Loading the programme from Hard Disk

Whilst the program is loading from hard disk, it is a good idea to introduce very generally
some of the aspects of Molecular Analyst 2-D PAGE.
Things to mention (Depending on the customer):
a. Molecular Analyst 2-D PAGE will run on either Windows 3.1 or greater OR Windows NT
b. Molecular Analyst 2-D PAGE is a 32-bit application, but for those customers who only
have 16-bit Windows (e.g. Windows 3.1, or Windows for Workgroups 3.11), We will
supply them with Microsoft’s WIN 32s, so that their version of Windows can operate
Windows 32-bit applications.
Molecular Analyst 2-D PAGE will handle images of virtually any size, depending only on the
capacity of the hard disk, and the patience of the scientist. It can accept 8-, 12-, or 16-bit
images and operate on those images WITHOUT any reduction.
c. Product support is considered as a vital function for two reasons:
• Customers should feel confident that their purchase will be supported.
customers of Molecular Analyst 2-D PAGE receive free updates.

All

Supporting customers gives Bio-Rad a direct link to the needs and problems of Molecular
Analyst 2-D PAGE users.

By the time you have explained some of these features, the main program screen will be in
front of the customer. It is then possible to explain the general lay-out of the screen,
indicating the functions of the Icons in the upper Menu bar (i.e. File, Print, Zoom facility,
stepping through a gel series using the video buttons in the bottom right hand corner, Spot
Detection or Peak Detection, Background Subtraction, Spot Measurements, Creating
/Selecting a Reference Gel, Matching of Gels, Editing Facilities and Parameter Changing
capability)
Show the Zoom in and out function using these buttons.
Do this with a small image since if you start showing this function during the demonstration,
the redrawing of the grey images from disk maybe slow and therefore not very impressive.
Next, you should explain that if you click on any of the analysis buttons, Molecular Analyst 2D PAGE will automatically load up the last experiment of the user now wanting to use the
software. This is a very important selling point. The software will be used by a number of
different scientists and each will have his own user name. When he starts to use the
software, he will enter this user name and the last experiment he was working on will be
loaded. In addition all the parameters optimised for his experiments, his preferred display of
measurements and display and positioning of various Windows will also be activated and he
is simply unaware of other set-ups required by other users of the software.

Now is the time to explain the main functions involved in analysing 2D Gels or a 2D gel series
i.e.
1. Access images and choose the portions of the image you wish to analyse by drawing a
rectangle on the grey image and asking this portion of the 2D gel to be passed onto all
other gels in the series.
2. Detect spots in the Image.
3. Editing of the Binary Image.
4. Perform background subtraction
5. Measure spots.
6. Carry out gel matching if appropriate.
7. Assign PI and Molecular Weight.
8. Analyse results
9. Use the database - the Database option is currently under development
What we have found to be the best way of demonstrating the software is to perform it in 3
definite stages with an option for a fourth. Because it is a complex software package, it
allows the customers to get more than one opportunity to see how the software operates,
but in slightly different ways.
The three stages are as follows.
1.

Using one of the Tutorial images, show how the system can very detect measure
and display measurements from a single gel. This shows the software in an
extremely impressive light.

2.

Using the three Tutorial images, perform Batch analysis of these three images. This
shows the system operating on three different images, carrying out Spot detection,
Spot measurement and Spot matching of the gels and then displaying the results in a
useful manner. Again this shows how quickly the system can operate once the
system has been optimised.

3.

Carrying out a full analysis of images showing editing, the ability to optimise the spot
detection parameters the flexibility of displaying data, and the ease that matching can
be aided with entering seed matches and many other additional features of the
software. This stage can also be performed using the customers own sample
images BUT DO NOT ATTEMPT THIS IF YOU BELIEVE THAT THEY ARE GOING TO BE
EXTREMELY DIFFICULT TO ANALYSE ON THE SPOT. Obtain some images from the
customer and analyse them in your own time.

Let’s start the demonstration and take you through the stages involved.
1.

To create an excellent first impression, tell the customer that, supplied with the
software, are three images of gels which are installed in the Tutorial section which
allows the user to practice using the software without having to use real data. Then
Restore the Tutorial by selecting Tutorial Menu and select the Restore Tutorial Data
option and OK the resulting Dialog Box

2.

Using the video buttons at the bottom right hand corner of the screen, select Gel 1.
Now tell the customer that you are going to Detect the Spots in the image then
produce measurements from these detected spots and then match to Gel 0 which by
default is the gel to which matching is performed. As soon as this is done, you will be
able to show measurements tables etc.

3.

Press the Detect Spots button.
A dialog box will appear asking you to
over-write existing data, OK this and the Spot Detection Dialog box will tell you Spot
detection is in progress.

4.

Very quickly, the Spot Detection is complete.

5.

The next thing to do is perform Spot Measurement, and this is performed by pressing
the Spot Measurement button.

6.

A dialog box appears during this process until complete.

7.

The next thing the customer is to be told is that the gel is now going to be matched to
Gel 0, the reference gel in the series, and this is carried out by pressing the Match
button.

8.

So, with three button mouse clicks we have performed the three main processes in
2D Gel analysis. The next thing to do is to look at the results.

9.

Double click on the Image button.

10.

The Gel display shows the Gel 1 grey Image, overlaid with its binary image the
software has generated (blue spots) and matched with Gel 0 binary image (red
spots). The open ‘circles’ shows spots which have a match and closed ‘circles are
spots which do not have a match in the other gel.

11.

Double click on the Measurements Icon
You will observe a Window containing all the spots in Gel 1 together with their
integrated volume measurements.

12.

Next, double click on the Zoom Icon

13.

You will now see the proportion of the gel which is being displayed in the Image
display . By clicking and dragging the green rectangle in the Zoom window a different
portion of the Gel can be displayed in the Gel Display window.

14.

Now double click on the Spot Icon.
Reposition the window between the Display and Measurements windows. Now
click with the cursor on any blue spot in the image and you will
obtain
instant
information on that spot and how it has changed between the gels in the series. Do
this for a few of the spots and show, by clicking on a closed blue spot that a match
could not be found in other gels in the series.

15.

Now explain to the customer that with very few operations we have detected,
measured and matched two gels in a series, and easily shown how they appear and
we are even able to very quickly obtain information regarding individual proteins in
the gel!!! That is potentially how easy the system is to operate.

The above 15 stages should take about 1-2 minutes !!! (working on a Pentium) so the speed
aspect of the program running on a PC (NOT a UNIX workstation) can be fully demonstrated.
We can now go into the second part of the demonstration and that is to explain that this
procedure would need to be done with each of the gels in the series that the customer has
picked. To speed up this process even more, there is a facility, under the Analysis menu
called Batch Processing, which allows the user to chose which gels in a series are to be
analysed and then with the single press of a mouse button, all the Spot detection, Spot
Measurements and Matching to a reference gel can be performed automatically. This we will
now show.
1.

Go to the Manual Ops Menu and select ‘Select Gels’. A dialog box will appear with 3
demo.tif images highlighted in blue. This means that all three will be analysed (by
clicking on individual images, they van be easily selected or deselected). Click on
Select All and OK the Dialog Box)

2.

Under the Analysis menu, select Batch Processing. Another dialog box appears
which asks what functions are to be performed. Make sure the following boxes are
checked
Detect Spots, Measure, Match.
Then press OK

3.

Depending on the PC which is running the program, the software is now performing
Detection, Measurement and Matching for the 3 gels that have been selected. On a
Pentium 90 , the whole process takes around 33 seconds!! On a 486 , DX2 66Mhz,
the process will take around 1 minute. This should REALLY impress the customer.
Whilst the processing is going on, you can simply explain what the software is doing
and by a little practice the whole process is complete by the time you have finished
the explanation. This is a wonderful comeback to the likes of Pharmacia and BioImage
who say that 2D gels or 2D Gel software needs to be analysed on a workstation!!!

At the end of the analysis, a dialog box (Batch Processing messages) is displayed explaining
the processes it has performed and any changes that needed to be made to the operating
parameters during the Detection measuring and matching. Close this box and now view the
results.

1.

Retrieve Image, Measurements and Spot Measurements as before, (its
usually
advisable to minimise some Windows after you display them , otherwise the screen
can get very cluttered.)

2.

Another Icon which can now be displayed is the Comparisons Icon.
This will display the spot number and Integrated volume measurements for each of
the gels that have been analysed and will also show which spots have matches and
those which have not. Minimise the window

3.

Another Icon which should be shown is Histograms.

By double clicking this, it shows how each protein spot has been expressed in each
of the three gels. It gives a rapid display of major changes in protein expression.

4.

Another Icon to maximise is Montage.
Once this window is available, explain that it shows how an individual protein
together with its immediate vicinity appears in each of the gels selected. Click on a
matched spot in the Image Window and see the same spot , together with its matched
counterparts in the other gels, appear.

We are now in a position to go into a detailed explanation of the software taking each step in
turn and show the full flexibility of the software

1.

Retrieval of images that require analysing and then
choosing Areas of interest to be analysed on those images.

The best way to start is to Open new File, explain how many images can be imported into a
single experiment by double clicking on Base Name and then adding various other files.
To carry out a good demonstration, you must have the security dongle installed in the
computer, otherwise you are only able to use the Tutorial images supplied with the software.
Assuming you have the security dongle in place, you should now choose the file called
MA_2d\tutorial which is a good range of images to use for your demonstration and double
click to establish the Base Name “demo”. With Molecular Analyst 2-D PAGE, selecting a base
name will select all the files in a series together, thus enabling all these files to be analysed
within a single experiment. There are present 3 gels in this series. and this is purely there to
demonstrate that the system can handle up to 36 gels in any series.
To do this, Take Manual Ops and choose the Select Gels Option. The resulting Dialog box will
allow you to select which gels you want. Once selected, Press OK.
Note: When looking at a new set of images for the first time, the actual setting up of the
parameters for Spot Detection can take a little time, being largely dependent upon the quality
of the 2D gels being analysed. There may be a very low dynamic range across the gel, there

may be large variations in spot size in the gel and there may be a lot of background noise to
contend with, so it is important to stress that customers MUST spend some initial time in
optimising the Spot detection conditions.
Another aid in speeding up this process is not to use the whole image but to select an area
in the gel (called an Area of Interest or AOI) and perform the Spot Detection on this. In
addition, scientists are often only concerned with a particular area of a gel or even a certain
few spots in the gel series and therefore AOI is an important option. . To show this take the
Manual Ops menu and select AOI. The resulting Gel Image window shows the complete
image and you then draw, with the cursor, a rectangle on the image representing the Area
of Interest. Once this is done, the dialog box giving you the option of passing this area onto
all gels in the series. Normally this would be chosen. For our purposes, when using the
Tutorial Images, the whole image is OK to use so simple take the ‘Whole to All’ option and
press OK.
As stated before, If you are using some of the customers own images which you have
scanned in it is often beneficial to take a small area of interest prior to carrying out spot
detection. It speeds up the Spot Detection procedure lessening the time required to optimise
the Spot Detection Parameters and therefore much more is more impressive to the customer.
Once AOI has been selected, we now want to ask the software to go ahead and detect the
spots in the areas of interest chosen.

2A.

Detection of Spots in the Selected Images

The first thing to do is select the gel you wish to detect the spots in and this is done using
the video buttons in the bottom right hand corner of the main program screen. Make sure the
first gel to be detected is Gel 0. Now we can ask the system to detect spots.
This can done either
(a)

Detect Spots button

or

(b)

via the Analysis menu and selecting Detect spots.

(a)

By using the Detect Spots button, the system automatically starts detecting the spots
with parameters previously entered. Whilst the spots are being detected the user is
informed of how much of the image has been processed

(b)

If you choose Spot Detection via the Analysis menu, then a dialog box becomes
available.

This allows the user to alter the various parameters in order to optimise the spot detection
process. For detailed explanation of the meaning of each of the parameters given in the
dialog box, see the Help Manual.
At this point it is an ideal point to explain that there are comprehensive Help Files and
Tutorials on line and can be run alongside the Gel Analysis process throughout. To do this,
choose the Help Menu, select the Index option and then double click on the Spot Detection
item in the section headed Procedures. Here it explains fully how the Spot Detection process
operates. You can then either re-size the Help window or minimise for future use or referral
during the gel analysis process.
Returning to the main process in hand, we can see that by increasing the value in the
sensitivity box, the fewer spots will be detected in the image, and by decreasing the value,
more spots will be detected.
IMPORTANT Before you demonstrate to the customer make sure that you know the meaning
of all the parameters involved in spot detection, and with the sample images provided, find
out how each of the parameters affects the Spot Detection Process. Again make the most
of the Help Files
When the spot detection has been completed we are informed by the system and we can
now view the results of the software’s efforts.
By double clicking on the Image icon in the bottom of the main window, an image of Gel 0 will
be displayed showing the grey image of the gel overlaid with the binary image the system
has generated indicating the spots it has found on the gel. Depending on how well you think
the system has done, you will either now change the parameters and try and optimise the
Spot Detection or carry out some editing of the binary image without altering and redetecting the spots
Notes: Show the possibility of resizing the Image Window
Show Zoom Icon at bottom of main Window

2B. Detection of Peaks
Certain gels contain spots in which separation has been poor. In these circumstances, the
Spot Detector will be unable to separate the spots, so the system uses a Peak Detection
algorithm specifically developed to identify just the peaks. Using this information, it
establishes a simple circular boundary for the spot.
It can be accessed from either

or

(a)

the Detect Peaks button

(b)

the Analysis menu, Detect Peaks menu

When Peak detection is accessed from the Analysis menu, the following Dialog box appears.

This is where the user can optimise the Peak detection parameters. Again, you must know
the meaning of the various parameters displayed in the box and these are described in detail
in the Tutorial / Help files on-line.
To see the effect that the various parameters have, make sure the Image Window is
displaying Gel 0, click on the Analysis Menu and chose the Detect Peaks menu option.
Accept the default values and OK the dialog box. and then conform you wish to perform the
Peak detection. The Image Window then displays the Detected peaks. Try now to repeat the
process with different Sensitivity values and repeat the process with various settings of
Grid size , Spot Scale and Representation values.
These are the results you should find.
A greater the Sensitivity setting the more peaks are found.
A smaller Grid Size results in less Peaks being detected.
A smaller Spot Scale results in less Peaks being detected.
A smaller Representation value results in a smaller circle representing the Peak.

3A.

Editing of the Spot Detection Binary Image

In virtually all cases, some editing of the binary image will need to be carried out, particularly
at the edges of a gel, where the spot detection algorithm cannot access every pixel in the
image. There may also be places in the image where the system does not detect all the
spots, does not split streaks or some artefact needs to be removed. To perform the editing is
very simple:
It can be accessed from either

or

(a)

the Edit Spots Button

(b)

the Manual Options Menu and select Edit Spots

In both cases, the following dialog box appears:

For editing purposes, it is often best to zoom in on the Display Image and this is done via the
Zoom button in the top Ribbon bar. As the full image is no longer displayed in the Display
Window, the Zoom Icon can be activated and this will indicate where you are with respect to
the total image.
You then look at a portion of your image, and determine what editing is required, either
Drawing (where additional binary image needs to be added) or Erasing, (where artefacts or
noise need to be removed or where a streak needs to be split). Select the appropriate choice
(Draw or Erase) and then choose the size of pen required. To Edit merely place the cursor
on the part of the image needed and by holding the left mouse button down either draw or
erase. Once completed, you will then use the scroll bars along the sides of the Image Display
window to step through the whole image and complete the editing function. Show a few
quick examples of editing and the effect of pen size
You will have noticed there is another option in this Dialog box and that is Grow Spot. This
allows the user to place the cursor on a particular spot of interest (after Clear Binary Image
has been chose) and simply by clicking the left mouse button, a binary spot is generated.
The ‘closeness of fit’ of the binary image to the underlying grey image can be optimised by
altering the value of %age in the box provided. Pick a prominent spot in the image and
demonstrate this option. This is invaluable for people who are interested only a few spots in
the image.

3B.

Editing of the Peak Detection Binary Image

When the Peak Detection parameters have been refined, you will probably still have to edit
the results manually as the system may have missed a few spots.
Editing the Peaks is done via either

or

(a)

the Peak Edit Button

(b)

the Analysis Menu, Peak editing option

To delete a peak, move the mouse cursor over the Peak to be removed and click on it with
the right mouse button. It will be drawn in black showing it has been removed. To add a
Peak, click on a point in the image Window with the left mouse button and the Peak will be
added with a green outline.
Once the editing has been completed, you would then move on to the next gel in the series
and repeat the above steps. i.e. Spot detection or Peak detection and Editing. Show how to
move onto the next gel in the series using the video buttons

4.

Spot Measurement

Once we have got to this stage of detecting and editing all the spots to satisfaction and, in
some cases determining the method of Background subtraction to be employed, it is now
time to carry out the spot measurement. i.e. calculate the integrated volume measurements
on each and every spot in the images of the series.
This is simply done via either

or

(a)

the Spot Measurement Button

(b)

by selecting Spot Measurement from the Analysis menu.

During the process of Spot Measurement, a dialog box is displayed to indicate the progress
of the process.
At the end of Spot Measurement, we are now able to display these spot measurements by
double clicking on the Measurements Icon at the bottom of the screen. As a default setting
the Spot number and Volume measurements are displayed.
These relate to the gel measured. However, if the user wishes to have more information,
then by opening the Manual Ops menu and selecting the Field Selections option, a wide
range of options of measurements for display are available. By adding checks to other
boxes more information can be displayed. Check, say Circularity, Area and Equivalent
Radius, OK the dialog box and then look at the measurements box and all the information is
displayed.
These measurements can also be displayed in graphical format by double clicking on the
Histograms Icon. Again, depending on what information is asked to be displayed via the
Select Fields box, these details are also displayed in the Histogram Window.
This function obviously displays a large amount of data and it is possible to discriminate
further as to what information the user requires.
The first is the Individual Spot Data which allows the user to simply point the cursor at a
selected spot and click. This will display the information on that spot alone throughout the
gels in the series.

The second is to look at ranges. By Opening the Manual Ops Menu, select the Range
Selection option and the resulting dialog box allows the user to enter ranges of Volume, Area
and Circularity. If you are only interested in say small or large spots then limits can be
entered which will allow the user to concentrate on those. There is also an option called
%age difference which will be discussed below.
The ‘Normal’ or Standard Gel Display, shows either just the reference gel and its
corresponding Binary image overlaid it alone or he reference gel binary image together with
the Slave gel and its corresponding grey image. However, there are two other possible
displays which are available, namely Saturation Display and Difference Display and we will
meet these a little later.

5.

Background Subtraction

After performing the Spot detecting and editing the next logical step is to tell the system what
background subtraction method the user wishes to use. Depending on the type of
Background subtraction used, this is sometimes carried out before the Spot Detection.
However, some of the methods offered can ONLY be done AFTER Spot detection.
This can be accessed by either

or

(a)

the Background Subtract Button

(b)

the Analysis menu taking Background Subtract option.

There are a number of options available and these are listed in the dialog box which appears
on selecting Background subtract. You should now demonstrate and explain the various
methods available to the user and explain their significance.

Background Subtraction Method
None:

Exactly as the name implies

Image Rectangle:

Draw a rectangle of whatever size you want somewhere on
the grey image. All the pixel values in the rectangle are summed and the average value
taken. This is the value used in all subsequent calculations.

Image Stripe:

A stripe is drawn either vertically or horizontally near the edge of the
image, the pixel values in each column or row in the stripe are summed, the average value is
calculated and this value is then subtracted from all other pixel values found in the
corresponding row or column in the image. It compensates for any co-migrating background
which may occur in the gel.

Lowest Boundary value and Average boundary value:
Explain that for each spot found, it will use the value chosen as being the background.
NOTE: These methods cannot be carried out until the gels have been measured
Once the background subtraction has been performed on all the gels in the series, you are
now in a position to move onto the next stage in the process.

Variable background:

You can choose a number of rectangles in the
image and the system will construct a contour map. This can be shown beautifully, once the
points have been chosen.
Select Display Image from the View menu, in the Grey image section change from Show
Grey to Show Background, OK this option and then view the gel display.
It is very impressive in that you are in effect compensating for variable background in the
image. (make sure that you show this with and without Contrast stretch being shown from
the Display Image dialog box).
When demonstrating this option, make sure that the rectangles you draw are sensible
representative areas of background, otherwise you can end up in real trouble!!
You are also able to show, using the View menu, Display Image option, the grey image with
background removed. If you have not made sensible areas of background, the resulting
image looks totally unrepresentative of the gel.

6. Spot Matching
This next function allows the user to directly compare any two gels in order to find how
spots have differed between gels. By asking the system to Match, we have to inform the
system to what gel do you wish to match the current gel.
Spot Matching can be accessed via either

or

(a)

Spot Matching Button

(b)

Taking the Match option from the Analysis menu

If you use the Analysis menu option a dialog box opens offering the possibility to alter the
Matching parameters that are applied to the two gels to perform the Matching. As with the
Spot Detection it is important that you know what each of these parameters controls and for
reference, it is a good point here to retrieve the Help files and view the section on Spot
Matching.
On selecting either the Match button or carrying out Matching via the Analysis Menu, the
system will tell you, via a dialog box, whether or not the system has been successful in
matching the two gels using the parameters given, and whether the system has altered any
of the values and if so what. It may also have not been able to match at all in which case it
will prompt you to enter some matches to act as ‘Seeds’. In either case we first need to
double click on the Image icon, first making sure that we are looking at the gel we wish to
view using the video buttons

To Enter Seeds, or perform editing of an initially successful Match, we need to use one of
three methods to edit. These are represented by the three buttons and can also be
accessed via the Manual Ops menu as Edit Seed Matches Dual Window, Edit Seed Matches
Montage and Edit Matches Overlay.

Each of these types of editing has there own particular advantage and users will use one of
these methods according to the type of gels they have.
For example, if you are using a fairly large gel series, the Montage option allows you to use
particular proteins in the images, which you know are fairly consistent in terms of
occurrence and use them as landmarks for all the gels you wish to Match.
The Dual Window option is often invaluable when the gels are very complex and it may be
difficult to perceive many discernible areas of common proteins. Overlaying two gels in this
instance would prove to be very confusing.
Overlay is the Standard method of display and if your gels are fairly conventional, is
probably the most convenient method to use for visualising the gels.

An important point to note here is that the software does NOT require there any seed
matches to be entered before it can make an attempt to Match gels. Many competing systems
have an absolute requirement for Seed Matches to be entered by the user and in some
cases there is a requirement for up to 10% of Matches to be so entered. This can be
extremely time consuming and frustrating for the user. If Matching is not successful in the
first instance, where Seed Matches have not been entered, using any of the three methods
to enter a small number of Matches almost invariably results in a successful Matching
(assuming you are matching comparable gels).
How ‘hard’ the system has to work to attain a successful Match can be largely influenced by
the user in how the images have initially been captured. When capturing images, it is
advisable that the CENTRES of the Autoradiogram images or whatever are as closely aligned
as possible. This is because the Matching algorithm starts in the centre of the images and
once it has found an initial match , works outwards towards the edges. Obviously the closer
the corresponding spots are to one another at the start, the easier the system finds it to
create a good match throughout the whole image. In turn this increases the chances of good
Matching throughout all the gels in the series and reduces processing time. Please look at the
help Files to learn the process of Matching
Demonstrate the uses of the different types of editing possible.
After editing the matches or creating some seeds for the Match to start with, the results can
now be looked at to see what changes have occurred between the gels. This is done using
the Comparisons Table, retrieved by double clicking on either:

or

(a)

The Comparisons Icon

(b)

Looking at the Histograms

The images can be viewed using the Image Display
When looking at Matched gels, the user often wants to view two gels to see what changes,
both qualitative and quantitative, have occurred between them. To aid this, there is the option
of Difference Map which is accessed from the View Menu, Display Image option. By
selecting this, the large Display Image dialog box appears. In the Display Type section, select
Difference map, OK this selection and then view the Image. The following type of display can
be seen.

There are now a series of different coloured spots, the colour code of which can be seen
(sometimes you will need to enlarge the Image window somewhat to see it). This will shows
what spots have increased in volume by a certain %age, those that have decreased, those
that have not changed and those which do not appear at all in the gel to which it is being
compared. The format of this display is controlled by checking the various boxes in the
Difference Map section of the Display Image dialog box. So you have control over what
spots are relevant (increased, decreased, same or new spots) and then set the limit of
increase or decrease by altering the %age figure. Finally your current gel can be compared
with any other gel in the series.
You will have noticed that there are three types of Image display
To select the Image Display type required , click on the appropriate button in the Display Type
of the section of the Set-up Display Dialog box accessed via the View...Display Image menu
option.
The Standard Display
Make sure that the Gel is not zero: you want to see both a reference gel and a slave gel
matched to it.
Matched spots are represented as outlines and joined by a line between their centres,
whereas unmatched spots are shown I solid colour. Reference spots are always drawn in
red and Slave spots in Blue.
The Difference Map
This always displays the current Slave gel with an overlay highlighting where the slave
spots differ from the Comparison Gel spots by some user definable amount. The percentage
figure in the Difference Map section of the set up Display Dialog Box can be changed to
isolate differences of a particular order of magnitude. There is also freedom as to which gel
the Current gel it is compared to.
The Saturation Map
This shows graphically, which parts of the Grey Image may have been saturated (overexposed) during image capture. It is important to note that it does NOT show where the
autoradiogram might have bee saturated - it simply shows where the device used to digitise
the image may have done so. Pixels which are at the maximum and minimum values that the
device can support are shown in green and black respectively.
See Help Manual for further information.
This now completes the major features of the demonstration, although there are other
features which have not been fully explored. These you should find out about in your own
time and include in the main body of the demonstration as and how you decide best for your
customers.
Some
of
these
features
are
mentioned
below.

Other features that may be considered in a demonstration and to
be mentioned only at the appropriate time include:
• Use of Clipboard for Exporting Text and Images
• On-Line Help and Tutorials
• Headers
• Protein Lists
• Profiles
• Intensity Calibration
• Reference Numbers

GENERAL OVERVIEW
TOPICS TO BE COVERED IN A DEMONSTRATION
1.
General Description of Molecular Analyst 2-D PAGE see page 1
of demo notes.
2.

General Description of the Main Program Window
Groupings in the Ribbon Bar and what they mean as groups and

individually.

Their relationship with the Menu Options at the top of the program screen
Icons along bottom of the screen
The movement between gels in a series via video buttons

3.
Description of the processes involved in 2D Gel Analysis and
customers generally want to do in 2D gel analysis
4.

Selection of gels and selection of Area of Interest on those
gels.

5.

Spot Detection/ Peak Detection and Display of image.

Optimisation of Spot Detection / Peak Detection parameters and meaning of terms in
Spot Detection / Peak Detection Dialog boxes.
Explanation of how the system detects spots.

6.

Editing of Binary Image.
For Spot Detection

Show Drawing and Erasing, using different pen sizes
and Grow Spot option

For Peak Detection

Show addition and removal of peaks

Repeat steps 5 and 6 for all gels in series

7.

Spot Measurement
Show volume measurements.
Show flexibility of measurements display and all other parameters

available

Show values as displayed in Histogram Format
Show Individual Spot Data

8.

Selection of Background Subtraction Method
Show all methods available and their significance

9.

Matching of Gels
Show possibility of No requirement for seeds matches
Show option for seeding gels and using those seeds before matching
Show possibility of constructing Creating and adding to Reference Gel
Describe the various ways in which matches can be edited and where they are
useful
Display of Comparisons tables

10.

Other Useful options
Saturation and Difference Map as Gel Display options
Range Selections
Profiles
Protein Lists and Headers
Possibility of displaying 2 gels at the same time
Creation of Reference Gels

